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નҭધ : -  ȶƨુતકના લખાણનો કોઈપણ ભાગ, લેખનશલૈી, રȩૂઆત શૈલી, ȺĆુાઓ અને તનેી ગોઠવણી વગેર°નો ઈલƈે˼ોિનક, યાિં́ક, પેƠપલેટ, ટ°ƨટ પેપર, Ⱥુ̃ ણ ક° અƛય કોઈપણ ƨવĮપમા ં

ઉપયોગ ̆કાશકની લ�ેખત પરવાનગી િવના કરવો નહӄ. આɂ ુȢૃƗય ગેરકાયદ°સર ગણાશ ેઅને તેમ કરનારની સામે કાȵનૂી કાય½વાહ� કરવામા ંઆવશે તનેી ખાસ નҭધ લેવી.  

 ઉપલƞધ મા�હતી આધાર° આ ȶƨુતકને ëિતર�હત બનાવવાનો ȶરૂો ̆યƗન કરવામા ંઆƥયો છે તેમ છતા ંસપંાદન અને Ⱥુ̃ ણ સમય ેમાનવસહજ ȹલૂ ક° ȧકૂને કારણ ેકોઈ ëિત રહ� 

જવા પામી હોય તો તેની કોઈપણ જવાબદાર� લેખક ક° ̆કાશકની રહ°શે નહӄ. આ ȶƨુતકનો ઉપયોગ કરવાન ેકારણે તેમા ંથયલેી ȹલૂȧકૂને કારણે કોઈપણ ƥય�ƈતને કદાચ કોઈપણ ર�તે 

ȵકુશાન ક° ëિત થાય તો તેȵ ુ ંઉĂરદાિયƗવ લેખક ક° ̆કાશકȵુ ંરહ°શે નહӄ. આ ઉપરાતં ȶƨુતકમા ંઆપવામા ંઆવેલા નામ, �ચ́ો, પા́, ƥયવસાય, ƨથળ, કાય½˲મ અને ઘટના લેખકની 

કƣપનાની ઉપજ છે અથવા તેનો કાƣપિનકĮપથી ઉપયોગ કરવામા ંઆƥયો છે. આ ȶƨુતકનો કોઈપણ ĥિવત અથવા Ⱥતૃ ƥય�ƈત ક° વાƨતિવક ઘટનાઓ સાથે કોઈ સમાનતા ક° સબધં એ સયંોગ 

મા́ છે, તથા તેનો હ°ȱ ુકોઈપણ ƥય�ƈત, સȺદુાય, સં̆ દાય, ધમ½ ક° ધાિમ�ક લાગણીને ȳુભાવવાનો નથી.  

નҭધ : કોઈપણ િવવાદ Ʌરુત ƛયાયëે́ને આધીન રહ°શે.  

Note : - No part of this work covered by the copyright herein may be reproduced, transmitted, stored or used in any form or by any means graphic, electronic or mechanical, 

including but not limited to photocopying, recording, scanning, digitizing, taping, web distribution, information networks, or information storage and retrieval systems, without the 

prior written permission of the publisher.  

 Although the author and publisher have made every effort to ensure that the information in this book was correct at the time of editing and printing, the author and 

publisher do not assume and hereby disclaim any liability to any party for any loss or damage arising out of the use of this book caused by errors or omissions, wheter such errors 

or omissions result from negligence, accident or any other cause. Fuether, names, pictures, images, characters, businesses, places, events and incidents are either the products 

of the author’s imagination or used in a fictitious manner. Any resemblance to actual persons, living or dead or actual events is purely coincidental and do not intend to hurt 

sentiments or any individual, community, sect or religion.  

Note : Any Dispute will be subject to Surat jurisdiction.   
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શુભȞેા સંદેશ 

 

 

 

 

 

 

 

ર̍વ સાવ̏લયા (GST Inspecter) 

જય ̋હ̬દ ̍મǋા,ે અાજ કાલ વતƙમાન સમયમાં સમાજનાે અેક માેટાે યુવા વગƙ સરકારી નાેકરી મળેવવાના 

સપના સેવતાે હાેય છે અને તેના માટે રાત – ̋દવસ મહેનતથી Ʈહાતાે હાેય છે. ઘણા બધા યવુા ̍મǋાે અેવા 

હશ ેકે જેઅાે કાે̎ચ̬ગ ɦારા અથવા કાે̎ચ̬ગ ̍વના તૈયારી કરતા હશે પરંતુ સાચી ̋દશામાં કરેલી તૈયારી જ 

તમને સફળતા સુધી પહા̲ચાડશે. તીર ચલાવવાની ̋દશા અને ટારગેટની ̋દશા અલગ હશ ેતાે તીર ટારગેટ 

સુધી પહા̲ચશે જ નહ̯. માટે સાચી ̋દશામાં અાગળ વધવું જͅરી છે. મારી રણની̍ત ટંુકમાં કહંુ તાે દરેક 

ઉમેદવારાેઅે પાછલા વષા̴ના ˾ધાƙɒક પ̋રƖાનાં પેપસƙ તથા ǐેક̋ટસ પેપસƙ અચકૂ સાેƶવ કરવા જેથી અેક 

અંદાજ અાવે છે કે કેવા ǐકારના ǐ˜ાે પૂછાય શકે. વારંવાર રીવીઝન કરવું, લખાણની ǐે̖Ƕસ, પાછલા 

વષા̳ના ǐ˜ાે સાેƶવ કરવા અે ˾ધાƙɒક પ̋રƖામાં સફળતાની પૂવƙ શરત છે. તૈયારીમાં અલગ – અલગ 

̍વષયાે માટે બે થી વધુ સાેસƙ / બુȋ વાંચવી નહી. મયાƙ̋દત પુƺતકાે જ વાંચવા. સંપૂણƙ અʬાસƿમની 

બદલે માેટા ભાગનાે અʬાસƿમ કવર થાય તેવાે અાǁહ રાખવાે. મારા ̍ મǋ વૈભવભાઇ ભંડેરીના અાǁહથી 

મ̲ ગાઈડʉ લેǴર પૂરા પાડેલ છે જે અાપને મદદͅપ બને તેવી અાશા રાખું છંુ.    
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બે̏લફ માેક ટે˶ – 1 

1.  સમાનાથ̰ શʣ અાપાે :  ‘˗ાસંગ’  

(A)  મહાવરાે   (B)  ˗સન   (C)  ˗ƺત   (D)  સંગ̍ત  

2.  સમાનાથ̰ શʣ અાપાે :  ‘દ̍યત’ 

(A)  ̌ǐય    (B)  ધન    (C)  લાવƩય   (D)  દેવંુ  

3.  ̍વરાેધી શʣ અાપાે :  ‘ǐધાન’ 

(A)  ધાન    (B)  સǐદાન   (C)  વ͂ર   (D)  ગાૈણ  

4.  શʣસમૂહ માટે અેક શʣ અાપાે : ‘અરજ કરીને માગેલું’  

(A)  ǐાવૃષ   (B)  રાવ    (C)  ǐા̎થ̭ત   (D)  અ̏જત  

5.  ̋ͅઢǐયાેગનાે અથƙ અાપાે :  ‘છાણાં થાપવા’   

(A)  ના પાડવી   (B)  છાણાં ભેગા કરવા  (C)  ખૂબ બદનામ કરવું  (D)  ǐ̐સ̏ɡ મળવી 

6.  કહેવતનાે અથƙ અાપાે :  ‘અાઠ વાર ન ેનવ તહેવાર’  

(A)  ખૂબ દૂ:ખ હાેવું   (B)  તહેવારે ભીડ હાેવી  (C)  અાનંદમંગલ સદાય હાેવું  (D)  ભ̍વˮની ̎ચ̬તા ન થવી  

7.  તળપદા શʣનું ̏શˠ ͅપ લખાે :  ‘તરાેયાે’  

(A)  ના̐ળયેર   (B)  તરાયાે   (C)  હાેડી    (D)   ઠીક̈́ં  

8.  તળપદા શʣનું ̏શˠ ͅપ લખાે :  ‘શહીદી’   

(A)  લȘ   (B)  સાƖી   (C)  સહારાે   (D)   સƖમ  

9.  સાચી ̀ેડણી શાેધાે.   

(A)  અ̍તવીશા   (B)  અ̍ત̍વષા   (C)  અતી̍વષા   (D)  અ̍ત̍વસા  

10.  ખાેટી ̀ેડણી શાેધાે.  

(A)  ̏નરાેપયાેગી     (B)  શર̌મ̬દંુ   (C)  ̏જƯસી          (D)  અ̍વ̍ધસર 

11.  સં̍ ધ ̍વǁહ કરાે:  ‘Ǘીશ’   

(A)  Ǘી+ઈશ   (B)  Ǘ+ઈશ   (C)  Ǘી+ઈષ   (D)  Ǘી+ઈસ  

12.  સં̍ ઘ ̀ેડાે: સુખ+ઈƯસા   

(A)  સુખાƯસા   (B)  સુખેƯસા   (C)  સુખીƯસા   (D)  સુખેƯષા  

13.  સમાસ અાેળખાવાે:  ‘યથાશ̘Ǹ’   

(A)  તɎુ̈́ષ   (B)  બહુǖી̋હ   (C)  અ˗̍યભાવ   (D)  ɦɺ   

14.   રેખાં̋કત ̍વશેષણનાે ǐકાર જણાવાે.  ‘અમારી માતાને અમે ખાેટના હતા.’  

(A)  દશƙનવાચક     (B)  સાવƙના̌મક   (C)  સȕંાવાચક   (D)  ગણુવાચક  
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 બે̏લફ માેક ટે˶ – 2 

1.  નીચે અાપેલ Ƹʣમાંથી કયાે શʣ ‘અજરાલ’ શʣનાે સમાનાથ̰ નથી?  

(A)  અછત   (B)  ભયંકર    (C)  યમદૂત   (D)  ̍વશાળ  

2.  સમાનાથ̰ શʣ જણાવાે : ‘અા̋દમ’  

(A)  અાળસુ   (B)  ǐારંભનું    (C)  અાકાર   (D)  અળવીત̈́ં  

3.  ̍વરાેધી શʣ જણાવાે : ‘અǁજ’  

(A)  અનુજ   (B)  પૂવƙજ    (C)  માે̍તયાર   (D)  અાગે  

4.  ̍વરાેધી શʣ જણાવાે : ‘બɡ’  

(A)  બંધન   (B)  માેત     (C)  મુǸ   (D)  બંધાયેલું  

5.  શʣસમૂહ માટે અેક શʣ અાપાે: ‘છે˒ાની પહેલું’   

(A)  છેવ̋ટયુ   (B)  સાેપાન    (C)  ઉɎાɳ   (D)  લાેથું  

6.  શʣસમૂહ માટે અેક શʣ અાપાે : ‘ ફાનસનાે ગાેળાે’    

(A)  ફાેટાે   (B)  ચીમની    (C)  કાચઘર   (D)  ગાેટાે  

7.  ̋ͅઢǐયાેગ : ̀હેર ચડવંુ   

(A)  કૃપા હાેવી.   (B)   સામ સામે ˾ધાƙમાં ઊતરવુ.ં  (C)  તાેફાન કરવું.   (D)  ˾ધાƙમાંથી બહાર રહેવું.  

8.  કહેવત : દૂઝણી ગાયની લાત પણ સારી  

(A)  ̀હેર ચીજ સાૈની માટે હાેય.    (B)  દૂઝણી ગાય નુકસાન પહા̲ચાડતી નથી.  

(C)  ફાયદાે કરાવનારાના દાેષ પણ સહી લેવા.   (D)  દૂઝણી ગાય દૂધ અાપતી નથી.  

9.  તળપદા શʣનું ̏શˠ ̄ͅપ અાપાે : ‘અા̐ળયાે’ 

(A)  અાળસ   (B)  કાકડી    (C)  અળ̐સયું   (D)  અારાેપ  

10.  તળપદા શʣનું ̏શˠ ͅપ અાપાે : ‘અાેસાણ’  

(A)  અાેસત   (B)  અા વષ̳    (C)  યાદ    (D)  ઉɇમ  

11.  સાચી ̀ેડણી જણાવાે :  

(A)  ̐બલકુલ   (B)  ̐બ̖́લ    (C)  વૈસેષીક   (D)  સાલાતુંલું  

12.  સાચી ̀ેડણી જણાવાે :  

(A)  બુભુƖુ   (B)  ̄ભા̍વક    (C)  ઉ̌મ̭    (D)  તા̔ɗક  

13.  સં̍ ધ ̍વǁહ કરાે: અંતગƙત  

(A)  અંતર+ગત   (B)  અંત:+ગƙભƙ    (C)  અંતર્+ગƙત   (D)  અંતર્+ગાભƙ  

 



 

Page | 21  
 

 બે̏લફ માેક ટે˶ – 3 

1.  સમાનાથ̰ શʣ શાેધાે : ‘ગદƙભ’ 

(A)  હથ    (B)  તુરંગ   (C)  ખર    (D)  ઊટં  

2.  કયાે શʣ ‘વલય’ શʣનાે સમાનાથ̰ નથી?   

(A)  તાેરણ   (B)  ǐલય   (C)  કપટ   (D)  કંકણ  

3.  ̍વરાેધી શʣ અાપાે : ‘͇ંગ’   

(A)  ટાેચ    (B)  ̏શખર   (C)  તળેટી   (D)  ખીણહીન  

4.  ̍વરાેધી શʣ જણાવાે : ‘સામુદા̍યક’  

(A)  વૈય̘Ǹક   (B)  સમ̑ˠ   (C)  સામા̏જક   (D)  અેકલવાયું  

5.  શʣસમૂહ માટે અેક શʣ અાપાે : ǋણ કલાકનાે સમયગાળાે   

(A)  કહર   (B)  સહર   (C)  ǐહર   (D)  મા̲સૂઝણું 

6.  શʣસમૂહ : જેનું ̖́ત પ̍વǋ છે તે -     

(A)  હિƺતની   (B)  સૂ̎ચ̖́તે   (C)  પુ̏ નતા   (D)  સુ̏ નતા  

7.  ̋ͅઢǐયાેગ : પગ ̀ણના થઈ જવા   

(A)  પગ ઉપર ભાર હાેવાે  (B)  મન ̑ખɿ થઈ જવું  (C)  પગને ઈ̀ થવી  (D)  મન ખુશ હાેવું  

8.  કહેવત : મફતનું ખાવું ને મ̙˵દમાં સૂવું   

(A)  મફત ખાવું દરેકને ગમે.    (B)  મફતનું ખાવાથી ઊંધ અાવે.  

(C)  ̎ચ̬તા ̍વનાનું ͂વન ͂વવુ.ં    (D)  મ̙˵દમાં ભાેજન મળે છે.  

9.  તળપદા ̄ͅપનું ̏શˠ ͅપ અાપાે : ‘ǋાંબાળુ’ં  

(A)  ǋાજવું   (B)  ǋાસું    (C)  તરભાણું   (D)  ̌પɇળનું માેટંુ તપેલું  

10.  તળપદા શʣનું ̏શˠ ͅપ અાપાે : ‘પાંજણ’  

(A)  બંધાણ   (B)  અાંજણ   (C)  ધૂળ    (D)  પં̋ કલ  

11.  સાચી ̀ેડણી શાેધાે.  

(A)  દુ̑ખયારણ   (B)  ͂ગીષા   (C)  ̄ાતɕં   (D)  ˗ુ̕ɋત  

12.  સં̍ ઘ ̀ેડાે : તɠ+ͅપ  

(A)  તǍપ્   (B)  ત:ͅપ   (C)  તǍͅપ   (D)  તાૈͅપ  

13.  સં̍ ધ છાેડાે : યુ̍ધ̑ˤર  

(A)  યુ̍ધ+̑ˤર   (B)  યુɦ+̗˺ર   (C)  યુ̏ɡ+̗˺ર   (D)  યુધ+અ̗˺ર  
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 બે̏લફ માેક ટે˶ – 4 

1.  અાપેલ શʣાેમાંથી કયાે શʣ ‘અ̖́તાે’નાે સમાનાથ̰ નથી?  

(A) મમɗ   (B)  અહંકાર   (C)  Ǔમણા    (D)  ભાન  

2.  સમાનાથ̰ શʣ જણાવાે : ‘̍વજન’  

(A)  દીધƙǍ̑ˠ   (B)  ̍વશાળતા   (C)  માણસની અવરજવરવાળું  (D)  વેરાન  

3.  ̍વરાેધી શʣ જણાવાે : ‘અાǍƙ’   

(A)  ભીનું   (B)  હ̋રયાળું   (C)  શુ˞    (D)  શુકલા  

4.  ̍વરાેધી શʣ જણાવાે : ‘તવંગર’  

(A)  કંગાલ   (B)  પસૈાદાર   (C)  તાલેવાન    (D)  અછત  

5.  શʣસમૂહ : ‘શરીરનાે સંવેદનશીલ ભાગ’   

(A)  સંવદેન˺ાન   (B)  સંવેદનશીલ   (C)  મમƙદાયક    (D)  મમƙ˺ાન  

6.  શʣસમૂહ : ‘બાળકથી માંડી વૃɡ સુધી’    

(A)  અાબાલવૃɡ   (B)  સમǁ   (C)  લાેઠ     (D)  ટાેળું  

7.  ̋ͅઢǐયાેગ : ‘ભગવંુ ભગવું ɪાન હાેવું’  

(A)  ભગવાનમાં ɪાન હાેવું     (B)  ભગવા કપડામાં ɪાન હાેવું   

(C)  બેɪાન બની જવું     (D)  ભગવાધારી સંતાેનું મન પરમાɒામાં લીન હાેવંુ  

8.  કહેવત : ‘બાઈ બાઈ ચાળણી’   

(A)  અઢળક ખચƙ કરવાે     (B)  જુદા જુદા બહાના કરવાે  

(C)  જે કંઈ બȢું તે જ લાભવાળું      (D)  પાેતાની જવાબદારી બી̀ને ̏શરે ઢાેળી દેવી  

9.  તળપદા શʣનું ̏શˠ ͅપ અાપાે : ‘પુંપરાે’  

(A)  પીપળાે   (B)  ̌પ̬જર   (C)  તૂરીયા   (D)  દીકરાે  

10.  સાચી ̀ેડણી શાેધાે.  

(A)  પɋર   (B)  શુǗૂષા   (C)  ̏નહારીકા    (D)  પાટાપ̯ડી  

11.  ખાેટી ̀ેડણી શાેધાે.  

(A)  ̍તર˱̋રણી   (B)  મȑીચૂસ   (C)  ̏ન:સાɫસ    (D)  રસાભીનીવષે 

12.  તળપદા શʣનું ̏શˠ ͅપ અાપાે : ‘દાેથાે’  

(A)  ખાેબાે   (B)  ખુરશી   (C)  પƺતાળ    (D)  દંડ  

13.  સં̍ ધ ̀ેડાે. ‘ǐ+̏નયાત’  

(A)  ǐ̒ણયાત   (B)  ǐયાત   (C)  ǐ̏નયાત    (D)  પ̋રયાત  
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 કƳʔૂટર માેક ટે˶ – 1  
 

1.  CPUનું પૂ̈́ં નામ શું છે?  

(A)   સƮેǇલ ǐાેજǶે યુ̏નટ  (B)   સƮેǇલ પરફેǶ યુ̏નટ (C)   સેƮǇલ ǐાેસે̐સ̬ગ યુ̏નટ (D)   સƮેǇલ પિƱલક યુ̏નટ  

2. કƳʔૂટરમાં સંǁહ કરી શકાય તેવી મેમરી કે જે કƳʔૂટર બંધ થતાં જ ભંૂસાઈ ̀ય છે તેવી મેમરી કઈ?  

(A)  રીડ અાેનલી મેમરી  (B)  રેɱમ અેȋેસ મેમરી  (C)  કાયમી મેમરી   (D)  અેકપણ નહ̯ 

3.  સામાʈ રીતે CDની સંǁહ Ɩમતા કેટલી હાેય છે?  

(A)  500 MB  (B)  600 MB  (C)  700 MB  (D)  800 MB 

4.  નીચેનમાંથી કઈ ભાષા ઉȝƺતરીય કƳʔૂટર ભાષા છે?  

(A)  મશીન   (B)  કાેબાેલ   (C)  અેસેʳલી   (D)  અાપલે તમામ  

5. 1024 બાઈટ (Byte) = ___________?  

(A)   1 KB  (B)  1 MB  (C)  1 TB   (D)  અેક પણ નહ̯  

6.  અાપેલ Meomry અેકમને ઉતરતા ƿમમા ગાેઠવાે. TB, KB, GB, MB  

(A)   TB>MB>GB>KB (B)  MB>GB>TB>KB (C)  TB>GB>MB>KB (D)  GB>MB>KB>TB 

7.  નીચેનામાંથી કયંુ DVD કરતાં વધારે ˶ાેરેજ Ɩમતા ધરાવે છે?  

(A)   સી. ડી. રાેમ   (B)  ưલાેપી ̋ડ˱   (C)  Ʊલ-ૂરે-̋ડ˱   (D)  રેડ-રે-̋ડ˱  

8.  કƳʔૂટરમાં મગજનું કામ કાેણ કરે છે?   

(A)   CPU   (B)  માઉસ  (C)  મેમરી  (D)  કીબાેડƙ  

9.  નીચેનામાંથી કયા ǐકારની મેમરીને ફǸ વાંચી શકાય છે?  

(A)   RAM  (B)  ROM  (C)  A અને B બંને   (D)  અાપલે પકૈી અેકપણ નહ̯ 

10.  કƳʔૂટર બંધ કરતાં મા̋હતી શેમાંથી નાશ પામે છે?  

(A)  VSD   (B)  RAM  (C)  ROM  (D)  CD 

11.  Virtual Memory સામાʈ રીતે ________ માં ̗˺ત હાેય છે.  

(A)  RAM  (B)  CPU   (C)  Flash Card   (D)  Hard drive  

12. પેન ǉાઈવને કƳʔૂટર સાથે ̀ેડવા માટે કયા ǐકારના પાેટƙનાે ઉપયાેગ થાય છે?  

(A)  COM 1   (B)  COM 2   (C)  USB   (D)  UBS 

13.  HTML દƺતાવે̀ે (Document)ને કયા ǐકારથી સેવ (SAVE) કરી શકાય છે?  

(A)  ̍વ̏શˠ ̋ɦઅંકી ̄ͅપ  (B)  યંǋ ભાષા સંકેતાે  (C)  ASCII અƖર   (D)  A, B, C પૈકી અેક પણ નહ̯ 

14.  કƳʔૂટર માે̏નટરને  ________ પણ કહેવાય છે.  

(A)  VDU   (B)  DVU  (C)  CCTV   (D)  અાપલે પકૈી અેકપણ નહ̯ 
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કƳʔૂટર માેક ટે˶ – 2  

 

1.  MS Excelની વકƙશીટમાં દેખાતી ઊભી-અાડી ǁે લાઇનને _______ કહે છે?  

 (A)  ǁે લાઇન   (B)  ǉાેઈંગ લાઇન   (C)  ǁીડ લાઈન   (D)  અેકપણ નહ̯ 

2.  MS Excelમાં લખવામાં અાવતી ફાેʸુƙલા વધુમાં વધુ કેટલા અƖરની હાેય છે?  

 (A)  55    (B)  155    (C)  255    (D)  355 

3.  Formula bar ________ માં હાેય છે.   

 (A)  Word   (B)  Excel   (C)  Wordpad   (D)  Power Point  

4. MS Excel ફાઇલનંુ અેȋટેƮશન શું હાેય છે? 

 (A)  .odc   (B)  .xls   (C)  .exc   (D)  .exl 

5.  ˿ેડશીપમાં અાલેખ ઉમેરવા માટે કયા મેનુનાે ઉપયાેગ થાય છે? 

 (A)  Insert > Tools (B)  Insert > Chart  (C)  View > Chart  (D)  Data > Chart  

6.  મુȕ મેમરી _____ છે?  

 (A)  વાેલટાઈલ   (B)  નાેન-વાેલેટાઇલ  (C)  (A) અને (B) બંને  (D)  ઉપરાેǸમાંથી અેકપણ ન̋હ  

7.  MS Powerpointમાં ƺલાઇડ શાે શͅ કરવા માટેની ફંȆન કી કઈ છે?  

 (A)  F4    (B)  F5    (C)  F6    (D)  F7  

8. પાવર પાેઈɰમાં ƺલાઇડ સાથે ________ ઉમેરી શકાય છે.  

 (A)  અવાજ   (B)  અહ̯ અાપેલ બધા જ  (C)  સમય   (D)  ̎ચǋ  

9.  કƳʔૂટરના મુȕ ભાગાેમાં કાેનાે સમાવેશ થાય છે? 

 (A)  મેમરી   (B)  ઈનપુટ-અાઉટપટુ ̋ડવાઇસ (C)  સીપીયુ   (D)  અાપેલ તમામ  

10.  ǒેઇન વાઇરસ કયા દેશના ǐાેǁામરે બના˗ાે હતાે? 

 (A)  અમે̋રકા   (B)  ર̏શયા   (C)  પા̋કƺતાન   (D)  ચીન  

11.  કƳʔૂટરમાં સાદા લખાણને સાંકે̍તક ભાષામાં પ̋રવતƙન કરવાની ǐ̋ƿયાને શું કહે છે? 

 (A)  અાેસીલǁાફી   (B)  ̋ƿપટાેǁાફી    (C)  અેયઅરી   (D)  અાપલે પકૈી અેકપણ નહ̯ 

12. WORMનું પૂ̈́ં નામ જણાવાે.  

 (A)  Wiscly Organize Replacing Machine  (B)  Wishely Organize Replacing Machine 

 (C)  Write Organize Replacing Machine   (D)  Wisely Organize Replacing Machine 

13.  ̍વ˝માં ̀ેવા મળેલ ǐથમ વાઇરસ કયાે હતાે? 

 (A)  અેજɰ ̖́થ   (B)  Chacha.com   (C)  ધ ̋ƿયર   (D)  અાપલે પકૈી અેકપણ નહ̯ 
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જવાબવહી  
બે̏લફ માેક ટે˶ – 1 

1 A 11 A 21 B 31 B 41 D 51 C 61 C 71 A 81 B 91 B 

2 A 12 B 22 B 32 C 42 A 52 A 62 B 72 A 82 D 92 D 

3 D 13 C 23 C 33 B 43 A 53 A 63 A 73 B 83 B 93 C 

4 C 14 B 24 B 34 C 44 B 54 D 64 D 74 C 84 D 94 B 

5 C 15 C 25 D 35 D 45 B 55 B 65 B 75 D 85 A 95 B 

6 C 16 C 26 A 36 A 46 B 56 A 66 A 76 C 86 D 96 C 

7 A 17 A 27 B 37 B 47 B 57 C 67 B 77 B 87 C 97 D 

8 B 18 A 28 A 38 A 48 B 58 B 68 D 78 D 88 D 98 D 

9 B 19 D 29 B 39 A 49 D 59 B 69 C 79 A 89 B 99 B 

10 A 20 D 30 B 40 D 50 A 60 D 70 D 80 A 90 B 100 A 

 

બે̏લફ માેક ટે˶ – 2 

1 A 11 B 21 A 31 A 41 A 51 A 61 B 71 A 81 B 91 A 

2 B 12 A 22 C 32 B 42 C 52 A 62 D 72 A 82 C 92 B 

3 A 13 A 23 C 33 C 43 B 53 A 63 D 73 D 83 C 93 B 

4 C 14 B 24 C 34 B 44 C 54 A 64 B 74 A 84 B 94 D 

5 C 15 C 25 B 35 D 45 B 55 A 65 A 75 A 85 D 95 C 

6 A 16 A 26 B 36 D 46 A 56 A 66 B 76 B 86 B 96 C 

7 B 17 D 27 B 37 C 47 D 57 C 67 C 77 D 87 C 97 A 

8 C 18 C 28 B 38 C 48 B 58 C 68 A 78 C 88 C 98 D 

9 B 19 D 29 C 39 B 49 D 59 B 69 A 79 A 89 B 99 A 

10 C 20 A 30 B 40 C 50 C 60 C 70 B 80 A 90 A 100 A 

 

બે̏લફ માેક ટે˶ – 3 

1 C 11 B 21 D 31 A 41 A 51 B 61 B 71 B 81 B 91 A 

2 B 12 A 22 B 32 B 42 C 52 A 62 C 72 B 82 C 92 B 

3 C 13 C 23 C 33 B 43 D 53 C 63 A 73 C 83 B 93 A 

4 A 14 D 24 A 34 C 44 C 54 B 64 C 74 C 84 A 94 C 

5 C 15 A 25 B 35 B 45 B 55 B 65 B 75 D 85 B 95 A 

6 B 16 D 26 B 36 C 46 B 56 B 66 B 76 C 86 C 96 B 

7 B 17 D 27 B 37 C 47 A 57 C 67 C 77 C 87 A 97 A 

8 C 18 B 28 A 38 B 48 C 58 B 68 C 78 D 88 B 98 D 

9 C 19 C 29 C 39 C 49 D 59 A 69 B 79 A 89 B 99 A 

10 A 20 A 30 B 40 D 50 B 60 A 70 D 80 C 90 A 100 B 
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સાદંુͅપ  

 
1. 12 + 6 × ( 5 - 3 ) + 4 

(A) 26 (B) 28 (C) 30 (D) 32 

 

 

 

 

2. ( 18 – 6 ) ÷ 3 x ( 4 + 2 ) 

(A)   12 (B)   14 (C)   16 (D)   24 

 

 

 

 

3. ( 9 + 7 ) × (8 - 5) ÷ 3 

(A)   14 (B)   16 (C)   18 (D)   20 

 

 

 

 

4. ( 25 + 5 ) ÷ 5 × ( 6 – 3 )  

(A)   12 (B)   10 (C)   14 (D)   18 

 

 

 

 

5. 15 × ( 4 – 2 ) + 9 ÷ 3 

(A)   31 (B)   33 (C)   35 (D)   37 

 

 

 

 

6. ( 12 ÷ 3 ) x ( 5 + 2 ) - 4   

(A)   20 (B)   18 (C)   22 (D)   24 
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મɪક , મɪ˺ , બહુલક 

1. નીચેના અાંકડાઅાે માટે મɪક (Mean) શાેધાે :  

1 , 5 , 8 , 12 , 15 , 18 , 20 , 25. 

(A) 12 (B) 13 (C) 14 (D) 15 

 

 

 

 

2. 10 ̍વɥાથ̰અાેના માȋƙ છે : 40 , 45 , 50 , 55 , 60 , 65 , 70 , 75 , 80 , 85 , 90. મɪ˺ (Median) શાેધાે. 

(A) 50 (B)   65 (C)   55 (D)   70 

 

 

 

 

 

3. 7 સʬાેના ઉંમર છે : 25 , 32 , 28 , 35 , 42 , 39 , 30. બહુલક (Mode) શાેધાે. 

(A)   35 (B)   32 (C)   39 (D)   None 

 

 

 

 

4. નીચેના અાંકડાઅાે માટે મɪક (Mean) શાેધાે : 14 , 22 , 34 , 40 , 25. 

(A)   24 (B)   26 (C)   27 (D)   20 

 

 

 

 

5.  અેક સવ̳માં ̍વɥાથ̰અાેઅે ઘરનુ ંકાયƙ કરવામાં કુલ સમયનાે અાંકડાે નીચે અાપેલાે છે:  

3 , 5 , 7 , 3 , 6 , 5 , 8. મɪ˺ (Median) શાેધાે. 

(A)   5 (B)   6 (C)   7 (D)   3 

 

 

 

 

6.  નીચેની ઊચંાઇઅાે (સે̔ɰમીટરમાં) 12 ̍વɥાથ̰અાેની છે :  

155 , 160 , 165 , 170 , 175 , 160 , 155 , 170 , 165 , 160 , 175 , 180 , 160. બહુલક (Mode) શાેધાે. 

(A)   160 (B)   170 (C) 175 (D) 165 
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કƳʔૂટર શાેટƙકટ  કી  

 
MS WORD SHORTCUT KEY 

1.  Ctrl + A : To select the next, image and table (Chart) on the page together 

2. Ctrl + B :  To Express selected text like – word, sentence, paragraph, etc. in bold form. 

3.  Ctrl + C :  Copying the selected content on the page. 

4. Ctrl + D :  To open the front Dialog box in Microsoft Word. 

5.  Ctrl + E :  To place the selected text in the center of the page. 

6.  Ctrl + F :  To search or Find ant text. 

7.  Ctrl + G :  It is used to open the Go to Dialog Box. 

8.  Ctrl + H :  It is used to open 

9.  Ctrl + I  :  To convert the selected text into italic font. 

10.  Ctrl + J :  To justify the selected paragraph. 

11.  Ctrl + L :  To align towards left a selected text on the page. 

12.  Ctrl + M :  To shift the selected text to the center. 

13.  Ctrl + N :  It is used to print Word documents. 

14.  Ctrl + O :  It is used to open the already saved Word document in the computer. 

15.  Ctrl + P :  It is used to print Word documents. 

16.  Ctrl + Q :  To Align towards left the selected text. 

17.  Ctrl + R :  To Align rightwards the selected text. 

18.  Ctrl + S :  To save Microsoft Word Documents. 

19.  Ctrl + T :  It is used to apply hanging Indent to a paragraph. 

20.  Ctrl + U :  This key is used to underline the selected text. 

21.  Ctrl + V :  It is used to paste the cut or copied content of a document. 

22.  Ctrl + W :  It is used to close the open documents in Microsoft Word. 

23.  Ctrl + Y :  It is used to redo in Microsoft Word. 

24.  Ctrl + Z :  It is used to undo in MS Word. 

25.  Ctrl + [ :  It is used to undo in MS Word. 

26.  Ctrl +] :   This shortcut key is used to decrease the font size of a selected text by I point. 
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ǐાેǁેસ રીપાેટƙ 

તારીખ માેક ટે˶ પરીƖના ગુણ મેળવેલ ગુણ  
 બે̏લફ માેક ટે˶ 1 ૧૦૦  
 બે̏લફ માેક ટે˶ 2 ૧૦૦  
 બે̏લફ માેક ટે˶ 3 ૧૦૦  
 બે̏લફ માેક ટે˶ 4  ૧૦૦  
 બે̏લફ માેક ટે˶ 5 ૧૦૦  
 બે̏લફ માેક ટે˶ 6 ૧૦૦  
 બે̏લફ માેક ટે˶ 7 ૧૦૦  
 બે̏લફ માેક ટે˶ 8 ૧૦૦  
 બે̏લફ માેક ટે˶ 9 ૧૦૦  
 બે̏લફ માેક ટે˶ 10 ૧૦૦  
 બે̏લફ માેક ટે˶ 11 ૧૦૦  
 બે̏લફ માેક ટે˶ 12 ૧૦૦  
 બે̏લફ માેક ટે˶ 13 ૧૦૦  
 બે̏લફ માેક ટે˶ 14 ૧૦૦  
 બે̏લફ માેક ટે˶ 15 ૧૦૦  
 કƳʔૂટર માેક ટે˶ 1  ૧૦૦  

 કƳʔૂટર માેક ટે˶ 2  ૧૦૦  

 કƳʔૂટર માેક ટે˶ 3  ૧૦૦  

 કƳʔૂટર માેક ટે˶ 4  ૧૦૦  

 કƳʔૂટર માેક ટે˶ 5  ૧૦૦  


